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Controls that can be used with the DAW ..........coevrverrree 10 trademarks of Avid Techno|ogyl Inc. or its subsidiaries in the
Cakewalk 11 United States and/or other countries.
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® Other company names, product names and logos in this
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Preparing the unit

Audio when in DAW control mode

When in DAW control mode, only audio input through Model 12
channels 1-2 can be heard.

Make the following settings as necessary.

® To control the DAW while listening to the DAW master audio
through this unit, set the MODE switch for channels 1-2 on
the Model 12 to “PC" and set the DAW master audio output to
these channels.

® On the MTR/USB SEND POINT screen, set to any setting other
than “PRE COMP” (default value). To send channel 1-2 LIVE
input from this unit to the computer, set the MODE switch to
“LIVE” (this disables monitoring of sound from the DAW).

NOTE
The state of the audio sent to the computer differs according
to the MTR/USB SEND POINT screen setting. See “MTR/USB
SEND POINT screen settings” on page 4 for details.

Connecting with a Computer

Refer to “Connecting a computer”in“3 — Preparation” of the
Model 12 Owner’s Manual, and connect to a computer.
Refer also to“12 — USB audio interface functions”and make
settings.

Starting DAW control mode

1. Set the channel 1-2 MODE switch on the Model 12
according to use.

2. When the Model 12 recorder is stopped, select DAW
CONTROLLER on the MENU Screen, and open the MODE
Screen.

For operation instructions, see “Menu operation
procedures”in“2 — Names and Functions of Parts” of the
Owner’s Manual.

MACKIE - Liwe

HUI - Fro Toals
MACKIE - Cubase
=5 I I

3. Select the control mode for the DAW being used.
For details about settings, see the manual of the DAW
application being used.

Options: MACKIE - Live, HUI - Pro Tools, MACKIE - Cubase,
MACKIE - Cakewalk, MACKIE - Logic, MACKIE - DP

4. Press the MULTI JOG dial.
A confirmation message will appear.

DA COHTROLLER
Start the DAl

control lar mode.
Are wou sure 7

Press the F1 IIREM button to return to the MODE Screen.

Model 12 operations

5. Pressthe F4 = button.

This opens the DAW CONTROLLER screen and enables DAW
operation.

AN COMTEOLLER

12245678
SOLD Qo0 Qo Q00

MARKER ——
S EE

¢ Immediately after connecting with the DAW as well as after
settings have been made in the DAW, the DAW settings and
the state and positions of the Model 12 buttons, knobs and
faders will not match. In this case, adjust the DAW settings to
match the Model 12 settings, or use the Model 12 buttons,
knobs and faders to match the DAW settings.

e If the unit is turned off while in DAW control mode, it will still
be in DAW control mode when restarted. To use it in ordinary
mode, end DAW control mode with the F1 button.

Ending DAW control mode

1. Pressthe F1 button to open the following message.

I LA COMTROLLER I

Are gou sure
to exit?y

2. Pressthe F4 IE= button to end DAW control.
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Model 12 operations

MTR/USB SEND POINT screen settings

The audio sent by USB depends on the Model 12 MODE switch settings and the MTR/USB SEND POINT screen settings.
For details about the MTR/USB SEND POINT screen settings, see “Selecting the positions that recording signals are sent from each

channel” under “Mixer functions”in the “9 — Other functions” chapter of the Owner’s Manual.
MTR/USB SEND POINT |COMP EQ MODE switch Audio sent to computer
LIVE Sound from input jacks is sent.
PRE COMP Disabled Disabled PC Sound from input jacks is sent.
MTR Sound from input jacks is sent.
LIVE Sound from input jacks is sent.
POST COMP Enabled Disabled PC Sound from computer is sent.
MTR No sound is sent.
LIVE Sound from input jacks is sent.
POSTEQ Enabled Enabled PC Sound from computer is sent.
MTR No sound is sent.

Regardless of the above settings, COMP/EQ is enabled for sound from the computer.
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Model 12 operations

Mixer controls that can be used when in DAW control mode

The following Model 12 controls can be used when in DAW control mode.

® The blue knobs, switches and faders in the illustration below are enabled.

FX fader

This operates the DAW master fader.

MULTI JOG dial

This can be used for locating.

Function buttons

Their functions depend on what is shown on the DAW CONTROLLER screen.
Press the MENU button to switch function button operations.

e B 2 W e

£/

TASCAM

H

1655/0050

silo

DAW CONTROLLER MARKER screen

LW CONTROLLER

123453678
SO0 2D D QD DD D

MARKER ——
= EER

® Usethe F2 button to set markers.

® Use the F3 IEZEM and F4 BEEE buttons to move between
markers.

The status of the DAW application SOLO switch is shown by
the SOLO item on the DAW CONTROLLER screen.

O:SOLO switch off
@ : SOLO switch on

DAW CONTROLLER TRACK screen

LW CONTROLLER

123453678
SO0 O QD QD DD

0 — TRACK —
vl = § = |

® Press the F2 IEEsM button to change the DAW repeat
function.

® Use the F3 BEZEl and F4 BEEE buttons to move among
tracks that can be controlled.

ATTENTION

After changing the tracks that can be controlled, the DAW
settings and the state and positions of the Model 12 buttons,
knobs and faders will not match. In this case, adjust the DAW
settings to match the Model 12 settings, or use the Model 12
buttons, knobs and faders to match the DAW settings.
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Model 12 operations

USB audio input and output when in DAW control mode

When in DAW control mode, only audio input through Model 12 channels 1-2 can be heard.

By setting Model 12 channels 1-2 as the outputs for the DAW master audio, the sound can be monitored with the Model 12 while
operating the DAW.

The following Model 12 controls can be used when in DAW control mode.

® The knobs, switches and buttons inside the green frame in the illustration below are enabled for sound sent to the computer.
® The blue knobs, switches and faders in the illustration below are enabled for sound from the computer.
® Regardless of operation, the red switches in the illustration below are always on

® Regardless of operation, the yellow knobs, switches and faders in the illustration below are fixed to the following settings for sound
from the computer

PAN knob (1-2) Regardless of knob operation, channels 1 and 2 are always L and R, respectively.
Channel faders (1-2) Regardless of fader operation, these are always 0 dB.
AUX 1/2/MAIN switches Regardless of switch operation, these are always MAIN.

e e e e e e e e iY==Y

Maodel 12

TASCAM

O

e [f the unit is turned off while in DAW control mode, it will still be in DAW control mode when restarted.
e To use it in ordinary mode, end DAW control mode with the F1 button.
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Making various DAW application settings

To enable the reception of messages from the DAW application,

first put the Model 12 into DAW control mode and then set the
DAW application.

Live

Windows
The following screens are from Live version 10.1.6.

1. Click“Options” > “Preferences...”

Model-12 DAW CON
File Edit Create Vie

G [Model-12 DAW CONTROLLER SETTING] - Ableto:

DI Map Crl+M
Edit Key Map Ctrl+K

~  Computer MID| Keyboard M

External Sync
~  Delay Compensation
Reduced Latency When Monitoring

Time Ruler Format >
Smaller Launch Quantization Ctrl+1
Larger Launch Quantization Ctrl+2
Triplet Launch Quantization Ctrl+3
~  Launch Quantization Enabled Ctrl+4

Snap Automation to Grid

Fixed Grid Ctrl+5
Draw Mode B
Follow Ctrl+Shift+F

~  Chase MIDI Notes

~  Solo Switches
Cue Switches

~  Soloin Place

Lock Envelopes

MIDI Arrangement Overdub

2. Select the“Link MIDI" tab, and set the Control Surface to
“MackieControl”.

Preferences n

[Model 12 MIDI (Pc]|

3. Settheinputto“Model 12 MIDI (Port2)".

Preferences n

kieControl __¥||Model 12 MIDI (Pc¥ | [Model 12 MIDI (Pcv|

sy

4, Setthe output to“Model 12 MIDI (Port2)".

Preferences u

Hacomml v Modnl:l? MID| Pov| MMBIJZMIDI P('
v | |None
] [None ]| Microsoft GS Wavetable Synth
¥| |None

Medel 12 MIDI (Part 2)

The H button on the Model 12 will light, showing that
remote control is enabled.
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Making various DAW application settings

Mac
The following screens are from Live version 10.1.7.
1. Click“Live” > “Preferences...”

i |:ile Edit Create View Options Help

Ut Live

Preferences...

Services >

Hide Live #8H
Hide Others "\_&H
Show All

Quit Live #Q

2. Select the”Link MIDI"tab, and set the Control Surface to
“MackieControl”.

Preferences

MackieControl _¥||Model 12 (DAW C(v| |Model 12 (DAW C(v|
v| [None
Launchkey Mini MK3 None

Launchkey MK2
Launchpad
Launchpad Mini MK3

MackieControl

3. Settheinputto“Model 12 MIDI (DAW Control IN)".

Preferences

MackieControl _¥||Model 12 (DAW C(v| [Model 12 (DAW C(v|
R =

Al “_——

|| Model 12 (DAW Control IN) | v|

4. Setthe output to“Model 12 (DAW Control OUT)".

Preferences

MackieControl  ¥||Model 12 (DAW C(¥|Model 12 (DAW C(¥|

None v||None v||None
None |
None |

The B button on the Model 12 will light, showing that
remote control is enabled.
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Controls that can be used with the DAW

The following Model 12 controls can be used to operate the
DAW application.

o F2 button (DAW CONTROLLER MARKER screen)
o F3 IEEE button (DAW CONTROLLER MARKER screen)
o F4 EEEM button (DAW CONTROLLER MARKER screen)
o F2 EI=M button (DAW CONTROLLER TRACK screen)
o F3 EE=M button (DAW CONTROLLER TRACK screen)

o F4 EE=3 button (DAW CONTROLLER TRACK screen)

® MULTI JOG dial (locate function)

® <<« /P> buttons

e H button

e » /Il button

e @ button

® PAN knobs (1-6, 7/8-9/10)

® REC buttons (1-6, 7/8-9/10)

® MUTE switches (1-6, 7/8-9/10)

® SOLO switches (1-6, 7/8-9/10)

® Channel faders (1-6, 7/8-9/10)

® FX fader (master fader control)

ATTENTION

Immediately after connecting with the DAW as well as after
settings have been made in the DAW, the DAW settings and
the state and positions of the Model 12 buttons, knobs and
faders will not match. In this case, adjust the DAW settings to
match the Model 12 settings, or use the Model 12 buttons,
knobs and faders to match the DAW settings.



Making various DAW application settings

Pro Tools

The following screens are from Pro Tools12 Ultimate version
2019.12.

1. Click“Setup”>"“Peripherals...”

[@ o ool
File Edit View Track Clip Event AudioSuite Optmr! Setup 'mdnw Avid Link  Help
are..

E Edit: TASCAM Model-12 DAW CONTROLLER SETTING = )
Playback Engine...

Video Sync Offset...

Session Ctrl+@
Current Feet+Frames Position...
Current Timecode Position...
External Timecode Offset...

MIDI

Click/Countof...
Preferences...

3. Set Receive From to “MIDIIN2 (Model 12 MIDI)".
On a Mag, set it to“Model 12 MIDI DAW Control IN”.

Peripherals

MIDI Controllers

v Model 12, DAW Control IN

none

4. SetSend To to“MIDIOUT2 (Model 12 MIDI)".
On a Mag, set it to“Model 12 DAW Control OUT".

MIDI Controllors

Tyoe Recowve From

# [ T (a2 0ANCrrNT| (waizoaoe e T S e

e O] CEE—
~ I R

5. Click“OK"

Peripherals X

MIDI Controllers

] e |

The M button on the Model 12 will light, showing that
remote control is enabled.

Controls that can be used with the DAW

The following Model 12 controls can be used to operate the
DAW application.

e F2 button (DAW CONTROLLER MARKER screen)
o F2 I={=8 button (DAW CONTROLLER TRACK screen)
o F3 EE=M button (DAW CONTROLLER TRACK screen)
o F4 = button (DAW CONTROLLER TRACK screen)
® MULTI JOG dial (locate function)

® <<«/»» buttons

e H button

e » /Il button

e @ button

® PAN knobs (1-6, 7/8-9/10)

® REC buttons (1-6, 7/8-9/10)

® MUTE switches (1-6, 7/8-9/10)

® SOLO switches (1-6, 7/8-9/10)

® Channel faders (1-6, 7/8-9/10)

ATTENTION

Immediately after connecting with the DAW as well as after
settings have been made in the DAW, the DAW settings and
the state and positions of the Model 12 buttons, knobs and
faders will not match. In this case, adjust the DAW settings to
match the Model 12 settings, or use the Model 12 buttons,
knobs and faders to match the DAW settings.
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Making various DAW application settings

6. Click“OK"

< Studic Setup X
The following screens are from Cubase 10.5. ——
e
s NN . "
1. Click“Studio” >“Studio Setup Chord Pacs
Chord Pads
___g"MID ort sets User Commands Reset
~ Il Renore Button Category Commang |
{ Fle Edit Project Audic MDDl Media Transpd ndow Hub Help PR User
1T ) AT TSRS Track Quick Controls User B
Transport F1
MixConsole Record Time Max Shift+F1
Video F2
MixConsole in Project Window ~ Alt<F3 L G T
o VST Audio System F3
VST Plug-in Manager Modsl Moxer ASIO S
Audio Performance... F12 VST System Link 4
ShiftF4
Video Player Fe =
+ & On-Screen Keyboard... Alt=K sniners
F&
[ Aenreoan More Options e
EEN | sar: itch Delay
Stuio Setup Enable Auto Select
Relay Click
y
Reset Appl
l OK l Cancel

2. Select Remote Devices and click the + at the top left of the

window. The M button on the Model 12 will light, showing that
remote control is enabled.

Controls that can be used with the DAW
The following Model 12 controls can be used to operate the
DAW application.
o F2 button (DAW CONTROLLER MARKER screen)
v o F3 IEZM button (DAW CONTROLLER MARKER screen)
e F4 BEEM button (DAW CONTROLLER MARKER screen)
3. Select”Mackie Control” o F2 EI=M button (DAW CONTROLLER TRACK screen)
— - o F3 IE=M button (DAW CONTROLLER TRACK screen)
o F4 EE=3 button (DAW CONTROLLER TRACK screen)
e | e MULTI JOG dial (locate function)
el e <</»»> buttons
[ besecome | e H button
Rl S22 e » /11 button
Bt ® @ button
4. Setthe MIDI Input to“MIDIIN2 (Model 12 MIDI)" ® PAN knobs (1-6, 7/8-9/10)
On a Mac, set it to “Model 12 MIDI DAW Control IN” ® REC buttons (1-6, 7/8-9/10)
® MUTE switches (1-6, 7/8-9/10)
fS‘E““:“‘“ — " ® SOLO switches (1-6, 7/8-9/10)
D?““’s — . ® Channel faders (1-6, 7/8-9/10)
L CRcEent ] M s ® FX fader (master fader control)

Button Category C

Remote Devices
User A
“Track Quick Controls User B
L Fi
ShifteF1

N~ mioina vodel 12 oy

ATTENTION

Immediately after connecting with the DAW as well as after
settings have been made in the DAW, the DAW settings and
the state and positions of the Model 12 buttons, knobs and
5. Set the MIDI Output to “MIDIOUT2 (Model 12 MIDI)" faders will not match. In .this case, adjust the DAW settings to
On a Mac. set it to “Model 12 DAW Control OUT” match the Model 12 settings, or use the Model 12 buttons,
! knobs and faders to match the DAW settings.

ShifteF2
E
ShifteF3

4 Studio Setup X
Mackie Control
Devices. MIDIN2 (Modei 12 MIDI) ¥
Ermmis MIDIOUT2 (Model 12 MIDI) v
Crord Pads
D Not Connected
User Commands
@ MIDI Port Setup
Remote Deves Button [ @ Microsoft GS Wavetable Synth

Usera

LD == + MIDIOUT2 (Medel 12 MIDI)
e Max Shift+F1
o r2
x - Shifeer2
m "
Moce! Mixer ASIO e
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Making various DAW application settings

4, Setthe Controller/Surface to“Mackie Control”.
Cakewalk

The following screens are from Cakewalk version 2020.01. Ao | Setectanycomtrot sracets) you want 1 e n Caket

. . Devices Import ADT Data. ¥
1. Click“Edit” > “Preferences...” Diver Setting: 2

Playback and Recording

Controller/Surface In Part OutPort AW WA calor
Configuration File
Sync and Caching
iews Inset Process Project  Utilities Window e "
Devices Controller/Surface Settings X
C‘C Ctl'l"‘ Z o Playback and Recordin
Import ! 9 Re Contraler’Suriace
Redo Ctrl+Y, Ctrl+ Shift+Z Instruments .
e Tracks k [ACT MIDI Cortroller Cercel | [P
History... [ conteoisurtaces ] Cakewak Gensic Suace O Consoke vien @1t
— - Fit Proj n Drum Map Manager S Ziliel GEDD
Select File
Folder Locations MIDI Devices...
Aim Assist Audio Data
Cut Ctrl+X
" ”
Cut Special Crlc Al X 5. SettheInput Port to “MIDIIN 2 (Model 12 MIDI)".
Copy Ctrl+Insert, Ctrl+C
LCopy Special... Ctrl+Alt+C
Paste Ctrl+V Audio A || select any control surface(s) you want to use in Cakewalk.
- A Devices e
Paste Special... Cirl+Alt+Y [ 0 B2 X
Driver Settings

e Playback and Recording Contraler/Surfice In Part Out Part Al W WAlookor

Delete Special... Configuration File
Sync and Caching
Preferences... miDI
i Controller/Surface Settings X
Devices g
&y DiModeli2.. v
Playback and Recording Controller/3 uface
Instruments Mackie Centrol ~
Cancel
(S Cantrol Surfaces ] Input Port ) Gonsols Visw @) Strips
Drum Map Manager (it
File
i, "
2. Select“Control Surfaces”. WD Devirs
Audio Data

Preferences x

A T L ey r— 6. Setthe Output Port to “MIDIOUT2 (Model 12 MIDI)".

perces X
Driver Settings Connectad Control /S urfaces

Playback and Recording Contraller/Surface In Port Out Fort A W Wl colar

Configuration File Audio A || Select any control surface(s) you want to use in Cakewalk.

Syn and Coching Deczs Import AT Data. X 4
o Driver Setings

Devices. Playback and Recording Gontroller/Surface In Port Out Port A W, WAl color

Playback and Recording R resh Frequency fmiliseconds) Configuration File

Sync and Caching

WAI D
ont Track view [ /] Cansole View Ofrackvien () Cansle View (@) Al Strips MiDl
Devices Controller/Surface Settings x
File Playback and Recording Controller/Surface
Folder Locations Instruments backie Conlrol v m— -
ancel
Audio Data 5 contro Sutaces ] Input P O Osnack view @ A1t

Hel
VST Settings Drum Map Manager MIDINZ (Model 12MIDI) Ela

Initialization File File Output Port
Advanced Folder Locations MID! Devices.
Project Audio Data
Record VST Settings
MiDI . Initilizatin Fils
O Basic @ Advanced 0K Cancel Apply Help

7. Click“OK"

Click the star mark at the top right of the window.

Audio || Selectany control surface(s) you want to use in Cakewalk.
Preferences
Devices ;
= import ACT Data. xl
Audio youwantt Driver Settings
Devies
£ Playback and Recording Controller/Surface In Port Out Port AL W WAl color
Drier ettings
Configuration File Mackie Dontrol - 1 MIDINZ (odel 12 M v MIDIOUT2 (Model 12 v 4 [
Playback and Recording Controller/Surface In Part OutPort AW WAl color
Configuration File Syne and Caching
Syncand Caching MiDI
o Devices Controller/Surface Settings X
Deices Playback and Recording R{ Controler/Surtace
Payback an Recording Fetesh Frequency iissconist nstruments o M oni -
Instruments. 5 -
i | TS Contol [Eerrr— nput Par oY pTp—
ol Suraces Traok iew (] Conscle View ST P—— -
Orrsckevien O Ganscle View @ A1t Drum Map Manager MIDINZ (Model 12MIDI) (it
Drum Map Manager
Fe File Output Port
Folder Locations MIDIDUT2 (Mogel 12MIDI | | MIDI Devices.
audio Data
VST Settings
Initalization File
Advanced
Project
Record
MiDI v
O Basic: ® Advanced 3 ancel gty Help

The M button on the Model 12 will light, showing that
remote control is enabled.
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Making various DAW application settings

Controls that can be used with the DAW

The following Model 12 controls can be used to operate the
DAW application.

o F3 EE=3l button (DAW CONTROLLER MARKER screen)
o F4 BEEE button (DAW CONTROLLER MARKER screen)
o F2 IE=M button (DAW CONTROLLER TRACK screen)
o F3 =M button (DAW CONTROLLER TRACK screen)

o F4 B button (DAW CONTROLLER TRACK screen)

® MULTI JOG dial (locate function)

<<«/»»> buttons

H button

» /11 button

@ button

PAN knobs (1-6, 7/8-9/10)

® REC buttons (1-6, 7/8-9/10)

® MUTE switches (1-6, 7/8-9/10)

® SOLO switches (1-6, 7/8-9/10)

® Channel faders (1-6, 7/8-9/10)

ATTENTION

Immediately after connecting with the DAW as well as after
settings have been made in the DAW, the DAW settings and
the state and positions of the Model 12 buttons, knobs and
faders will not match. In this case, adjust the DAW settings to
match the Model 12 settings, or use the Model 12 buttons,
knobs and faders to match the DAW settings.

12 TASCAM Model 12 DAW Controlmode Manual

Logic Pro

The following screens are from Logic Pro X version 10.4.8.
1. dlick“Logic Pro X" > “Preferences...” > “Advanced Tools..."”

LogicProX ile Edit Track Navigate Record Mix View Window 1 Help

B Model-12 €

General...
Audio...
Key Commands Recording...
-5 MIDL...
Display...
Score...
Movie...

Sound Library

Provide Logic Pro Feedback
Download Logic Remote...
Learn About

Services
Advanced Tools...
Hide Logic Pro X ®
Hide Others < Reset All Except Key C

Show All

Plug-in Manager...

Quit Logic Pro X Chord Grid Library...

2. Putchecksin all the boxes.

Preferences

v Show Advanced Tools

addi

Additional Options

v Audio
Enab

v Surround

v Score
Enables the full fe:

v Advanced Editing

Disable All

3. Select the “Control Surfaces” page, and click “Setup...”

Gene Help Tags |~ MIDI Controller:

Controller Assignments... Setup...




Making various DAW application settings

4, Click”New”>"“Install...”

Controls that can be used with the DAW

The following Model 12 controls can be used to operate the
DAW application.

o F2 =8 button (DAW CONTROLLER TRACK screen)
o F3 IE=M button (DAW CONTROLLER TRACK screen)
o F4 = button (DAW CONTROLLER TRACK screen)
MULTI JOG dial (locate function)

<<«¢/»»> buttons

M button

» /11 button

@ button

PAN knobs (1-6, 7/8-9/10)

® REC buttons (1-6, 7/8-9/10)

® MUTE switches (1-6, 7/8-9/10)

[ XSK0) Control Surface Setup

5. Select”Manufacturer: Mackie Designs” and “Model: Mackie ® SOLO switches (1-6, 7/8-9/10)
Control’, and click"Add". e Channel faders (1-6, 7/8-9/10)
° o ® FX fader (master fader control)

Manufacturer A Model Module

M-Audio USB Trigger Finger
M-Audio (Midiman) iControl iControl ATTENTION

et Al o Immediately after connecting with the DAW as well as after

HuI HUI

HUIChamnel Stipsonly  HUI settings have been made in the DAW, the DAW settings and
pr— the state and positions of the Model 12 buttons, knobs and

Mackie Control Logic Control

. . faders will not match. In this case, adjust the DAW settings to
LR ey A match the Model 12 settings, or use the Model 12 buttons,

Mackie Designs M o Logic Control .
wonome Monome 64 knobs and faders to match the DAW settings.
KOMPLETE KONTROL S61
IMPACT LX49

6. For Device: Mackie Control, set the Output Port to “Model
12 DAW Control OUT".

[ JeK ] Control Surface Setup
Edit v New v

N 1\
‘¥ Device: Mackie Control

Outpu P| v Model 12 DAW Control OUT

@ Mackie Control

W CS Group: Control Surface Group 1

7. For Device: Mackie Control, set the Input Port to “Model 12
DAW Control IN".

[ ) ® Control Surface Setup.
v New v
Mackie Control
Output Port: Model 12 DAW Control OUT
ny

Model 12 DAW Control IN

@ Mackie Control

‘W CS Group: Control Surface Group 1

The H button on the Model 12 will light, showing that
remote control is enabled.
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Making various DAW application settings

DP (Digital Performer)

The following screens are from Digital Performer 10.1.

1. Select“Setup” >“Control Surface Setup...”

@ Mode-12 DAW CONTROLLER SETTING

File Edit View Region Audic Project Studi Lt Window  Help

W Cormand... Shift-Space
Commands Shift-L

“ar» «H >
S sl & bt Wi bt @ 2

Input Filter...
Event Chasing..

Automation Setup...

Legend...

Time Formats Ctrle Alt=T

Frame Rats
Receive Sync...

Transmit Sync...

Control Surface Setup...

Audio System
Configure Audio System
Audio System Clock

2. C(lickthe + at the right side of the window.

Control Surface

Listan to control surfaces in background

1o add a driver o your configuration.

3. Set the Unit to “Mackie Control”.

Control Surface

Unit nout Port

. Mackie Control 2 IDI-

4, Setthe Input Port to “MIDIIN2 (Model 12 MIDI)".
On a Mag, set it to “Model 12 MIDI DAW Control IN”.

TASCAM iXR (Missing)

US-322 (Missing) Model 12 DAW C
US-366 (Missing) TR
US-1800 (Missing) Model 12 DAW C

US-122 MKII (Missing) Model 12 DAW C

US-144 MKII (Missing) Model 12 DAW C

Model 12 DAW C¢
Model 12 DAW C¢
Model 12 DAW Ct
Model 12 DAW C¢
Model 12 DAW C¢
Model 12 DAW Ct 15
Model 12 DAW Control IN-16
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5. Setthe Output Port to “MIDIOUT2 (Model 12 MIDI)".
On a Mag, set it to“Model 12 DAW Control OUT".

Note: Top to Botiom = Left 1o Right

¥ Model 12 DAW Control OUT

TR NI V- S
. Pt ® L

TASCAM iXR (Missing)
US-322 (Missing)
US-366 (Missing)
US-1800 (Missing)
US-122 MKII (Missing)
US-144 MKII (Missing)
US-16x08 (Missing)
US-20x20 (Missing)
118-7%7 FMiccin)

6. Click“OK"

Control Surface

The B button on the Model 12 will light, showing that
remote control is enabled.

Controls that can be used with the DAW

The following Model 12 controls can be used to operate the
DAW application.

o F3 EE=3l button (DAW CONTROLLER MARKER screen)
o F4 EEEE button (DAW CONTROLLER MARKER screen)
o F2 =M button (DAW CONTROLLER TRACK screen)
o F3 EE=M button (DAW CONTROLLER TRACK screen)

o F4 =M button (DAW CONTROLLER TRACK screen)

® <<« /P> buttons

e H button

e » /1l button

e @ button

® REC buttons (1-6, 7/8-9/10)

® MUTE switches (1-6, 7/8-9/10)

® SOLO switches (1-6, 7/8-9/10)

® Channel faders (1-6, 7/8-9/10)

® FX fader (master fader control)

ATTENTION

Immediately after connecting with the DAW as well as after
settings have been made in the DAW, the DAW settings and
the state and positions of the Model 12 buttons, knobs and
faders will not match. In this case, adjust the DAW settings to
match the Model 12 settings, or use the Model 12 buttons,
knobs and faders to match the DAW settings.



MIDI Implementation Chart

MIDI Implementation Chart DAW Control ports

Function Transmit Recognize Remarks
. When power on X X
Basic channels
Settable X X
When power on X X
Mode Message X X
Altered |
Range O O HUI Mode: Active Sensing
Note number
Range (@) (@) Mackie Ctrl Mode: Key, LED
Note on
© O HUI Mode: Active Sensing
Note off X X
Velocity
Note on @) @)
Mackie Ctrl Mode: Key, LED
Note off X X
Polyphonic X X
Aftertouch
Channel X X
Pitch bend O X Mackie Ctrl Mode: Fader
(@) (@) HUI Mode: Fader, LED, Switch Ctrl, PAN
Control change
@) O Mackie Ctrl Mode: PAN, Encocder
X X
Program change -
Settingrange  |ae |
System exclusive (@) (@) Mackie Ctrl Mode
Position X X
Song select X X
System common
Quarter frame X X
Tune X X
Clock X X
System real-time
Command X X
Local on/off X X
All notes off X X
Other
Active sense X X
Reset X X
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